POLITECNICO DI TORINO

RPN

Master of Science in Civil Engineering Thesis

MEP modelling of a subway station to an
executive level of design with clash detection
verification

Case study: Collegno Centro Station

Tutors: Candidate:
Prof. Anna Osello Gabriella Monticelli
Dott. Greta Lucibello

December 2020






“Ai miei nipotini,

fonte infinita di gioia e spensieratezza.”



Abstract

In this historical period construction industry is experiencing an important

change as a result of the technological transformation of the field.

Indeed, transferring all the data of brand new or existing constructions on a
digital base is becoming a common tendence.
BIM (Building Information Modelling) methodology plays a fundamental
role in this objective and provides the control of all the information related to

a project.

An important aspect of BIM can be found in the MEP modelling, which studies
the three systems (Mechanical Electrical and Plumbing) linked to every

building project and constitute an integral part of it.

MEP design is important for planning, decision making, accurate
documentation, performance and cost-estimation, construction, and

operating/maintaining the resulting facilities.

This thesis contains the modelling of some of the MEP systems made with
Revit software of a future subway station of the metropolitan city of Turin,

the Collegno Centro station.

Once models of various disciplines were obtained, the focus turned to macro
and micro clash detections thanks to the use of different software.
This last operation has been done both between single disciplines and
structural and functional models of the subway station and between MEP

disciplines themselves.

In addition, it has been analysed a more theoretical part of the MEP which
regards drafting of the coding of the modelled single parts of plant

engineering.
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1 BIM Engineering

In the last years, the use of Building Information Modeling (BIM) has grown
significantly as an optimizing factor of the whole building sector, supported by
innovation technology. As a methodology, BIM allows the actors of AECO
(Architecture, Engineering, Construction and Operation) industry to share
information through interoperability, improving data transfer and updating
through the development of a 3D parametric model able to collect all the

information needed for a project. [1]

This thesis follows one of the main steps of BIM workflow, that is considered the
engine of the VDC (Virtual Design and Construction) process. The procedure is

represented by a scheme mainly composed of three sections:

e Inputs data, composed by a set of processes ecosystems and stored data;

e BIM Engine, a machine where 3D parametric model is generated with
geometrical and alphanumerical detail;

e Outputs data, the products generated by the BIM engine in a form of

exchange formats, oriented to target applications used by the project team.

Therefore, the use of innovative methods such as Building Information Modelling
(BIM) allows professionals to optimize their work through developing 3D
parametric models that contain large amount of data useful for the whole building
life cycle. The meaning of BIM consists of a set of activities to create, manage,
derive and communicate information among stakeholders based on an

informative model that is a digital representation of reality.

The new concept of building industry should be based on efficient process where
the involved actors usually fill-in and extract data from 3D parametric models
that are frequently updated. Thus, digitalization is based not only on processes
and technology, but also on people that need training to understand strengths

and challenges of BIM methodology. [2,3,4,5]
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1.1 Interoperability

In the project delivering process, many actors are involved. These actors are
usually grouped by parties, which are at the same time assembled into teams
when they have to perform a specific task. Parties exchange information in the
appointments. The appointed party is who provides the information to the
appointing party. This information must follow some requirements in order to be
exchanged. The information is formed by containers and the set of containers
form the information model. These information containers are practically all the
files generated by the project team, which can have several extensions depending

on its nature.

A appointing party
lead appointed party

C appointed party
variable amount

1 project team
2 illustration of a delivery team
3 task team(s)

< information requirements and
information exchange

4~ [nformation coordination

Figure 1: Interfaces between parties and teams for the purpose of information management
[https://bim.acca.it/uni-en-1s0-19650-2019-pubblicate-in-italiano-le-norme-internazionali-sul-bim/]

It is important to mention that there is not only one unique software
encompassing all the activity spectrum. A software is a tool created for a
particular purpose. During the information creation process, designers may need
different software of different firms, which use different formats and languages.

This is where the term interoperability comes up.
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In order to reach an objective, all actors must unify the way information is

exchanged.

The idea of creating standards is born following the same principle. Actors that
follow the same standards speak the same language. Unfortunately, there are lots
of different standards even in the same country, like the case of USA. They were
created in order to fulfil different requirements. The use of British standards for
managing information became very popular on BIM environment, so nowadays
the creation of an international standard based on those standards is in progress.
The term that defines how well is information exchanged between two different
software, is called interoperability. Usually during the process of importing and
exporting files from a software to another one, some data are lost. These data can
be graphical or even alphanumerical. The best is having a model interchange
without distortions. The less information is lost, the better interoperability

between two different software is.

2D data exchange BIM interoperability

Architect Installer Installer

g

Facility
Manager

lrv.'l

Constrution Buiider Consirution Builder
Manager Manager

Figure 2: Interoperability. [https://biblus.accasoftware.com/en/ifc-whats-it-for-whats-its-connection-
with-bim/]
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1.2 Common Data Environment

The Common Data Environment (CDE) is a central repository where construction
project information is housed. The contents of the CDE are not limited to assets
created in a ‘BIM environment’ and it will therefore include documentation,
graphical model and non-graphical assets. In using a single source of information
collaboration between project members should be enhanced, mistakes reduced

and duplication avoided.

Many BIM protocols, in particular the CIC BIM Protocol , propose the use of a
common data environment. The ultimate aim being to improve the creation,
sharing and issuing of information that underpins the delivery of your project.
The idea of collaboration to drive improved results and efficiencies is at the heart
of implementing a Building Information Modelling (BIM) approach on

construction projects.

As a single source of information there’s no arguments about which version of
information should be being referenced. The CDE should serve as the ultimate

source of 'truth' and bring a number of advantages for all involved:

e Shared information should result in coordinated data which will, in turn,
reduce both time and cost on your project.

e Project team members can all use the CDE to generate the documents/
views they need using different combinations of the central assets,
confident that they are using the latest assets (as are others).

e Spatial co-ordination is inherent in the idea of using a centralized model.

e Production information should be right first time assuming that

contributors adhere to processes for sharing information.

In Italy, the data sharing environment is called ACDat and is thus defined by art.2
of DM 560/2017: The data sharing environment is defined as a digital, organized
and shared data collection environment for a work, and structured into
information on, and primarily traceable to, digital models and processes, based

on an IT infrastructure whose sharing is regulated by precise security access


http://www.bimtaskgroup.org/bim-protocol/
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systems, traceability and historical sequence of changes made to information

content, conservation over time and relative accessibility of information heritage

content, definition of responsibilities in the development and protection of

intellectual property. [20]
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Figure 3: Common Data Envirmnent scheme.
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In the UK technical standards the CDE is defined in an organic manner, while the
Italian standard, UNI 11337, does not specify how the ACDat will work and how
it will be organised, but only the requirements it will have to meet [16]:

« accessibility, according to certain rules, by all actors involved in the process;

» traceability and historical sequence of updates of the data contained;

« ease of access, storage and extrapolation of data (open data exchange protocols);
« conservation and updating over time;

« assurance of confidentiality and security.

In addition, UNI 11337-7 defines the requirements of four professional profiles:
« CDE Manager Data Sharing Environment Manager ;

» Manager of Digitized Processes BIM Manager ;

« BIM Coordinator Information Flow Coordinator ;

« Advanced Information Management and Modeling Operator BIM Specialist.
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1.2.1 BIM 360

Developing this thesis BIM 360 Docs has been used as Common Data
Environment platform, but depending on a construction stages, these are various

Autodesk BIM 360 solutions to be progressively included in the process:

e BIM 360 Teams and C4R (collaboration for Revit)
e BIM 360 Glue

e BIM 360 Docs

e BIM 360 Layout

e BIM 360 Plan and BIM 360 Field

e BIM 360 Ops

CONCEPTUAL DESIGN DETAIL DESIGN CONSTRUCTION PRE-CONSTRUCTION CONSTRUCTION COMMISSIONING
DOCUMENTATION AND HANDOVER

BIM 360 TEAM / COLLABORATION FOR REVIT

BIM 360 DOCS

BIM 360 GLUE

- ]
BIM 360 LAYOUT

BIM 360 PLAN

BIM 360 FIELD

BIM 360 OPS

Figure 4: Different kind of section of BIM 360 as CDE. [https://www.linkedin.com/pulse/future-bim-
common-data-environment-autodesk-360-mileta-pejovic/]

BIM 360 Docs is a unique, "all in one place" common data environment for all
types of documents. As an addition to common document type file formats such
as pdf, xls, docx, it also supports all Autodesk file formats and documents within

them.

It allows to create new folder within different access permission. It is possible to
add people to this folder and make sure that the right people have the access to
the right information. In fact, when someone is added to the folder it is asked to

select a permission level that include:

e View only: User/role/company may view documents, add private markups,

and create issues.


https://knowledge.autodesk.com/support/bim-360/learn-explore/caas/CloudHelp/cloudhelp/ENU/BIM360D-Document-Management/files/To-Work-with-Document-Management/GUID-2E10E17D-D814-4357-AD94-7AD10B1B55D4-html.html
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o View + Download: User/role/company may view documents, add private

markups, create issues.

o Upload only: User/role/company may upload documents but not see the

folder contents.

e View + Download + Upload: User/role/company may share their own

documents with team members and view any other documents in that folder.

o View + Download + Upload + Edit: User/role/company may share their own
documents with team members, view and edit any other documents in that

folder, and publish markups.

o Folder Control: User/role/company may share their own documents with
team members and view and edit any other documents in that folder. With
folder control permission they can also carry out tasks within that folder that
are usually restricted to the project administrator. This includes creating title
blocks, adding project members, managing permissions, and editing set

assignment. This permission level offers the greatest access to folders. [28]

The approval workflow feature enables document managers to facilitate, control,

and automate the distribution of documents to project members.

Members designated as reviewers can then review and comment on the
documents, and members designated as approvers can give final approval for the

documents to be used.

The Review and Approval Process is now available to both the BIM 360 Plans and
Project folder workflows. [29]

Teams use issues to identify and communicate areas of concern or improvement
with project documents. Within the Project Admin module, project
administrators can create issue types, sub-types, and custom attributes. They also

control permissions for issues across all modules in BIM 360.

In Document Management and Design Collaboration, issues are associated with
documents. In Field Management, issues can be associated with documents or

with an on-site quality, safety, or other problem.


https://knowledge.autodesk.com/support/bim-360/learn-explore/caas/CloudHelp/cloudhelp/ENU/BIM360D-Document-Management/files/To-Work-with-Document-Management/GUID-2E10E17D-D814-4357-AD94-7AD10B1B55D4-html.html
https://knowledge.autodesk.com/support/bim-360/learn-explore/caas/CloudHelp/cloudhelp/ENU/BIM360D-Document-Management/files/To-Work-with-Document-Management/BIM360D-Document-Management-To-Work-with-Document-Management-To-Work-with-Document-Sets-html-html.html
https://knowledge.autodesk.com/support/bim-360/learn-explore/caas/CloudHelp/cloudhelp/ENU/BIM360D-Document-Management/files/To-Work-with-Document-Management/BIM360D-Document-Management-To-Work-with-Document-Management-To-Work-with-Document-Sets-html-html.html
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The Issues workflow is controlled by two status sets, each with specific options in

the Status drop-down menu on the Issue dialog;:

e Basic (for Document Management and Design Collaboration issues):
Draft, Open, Answered, Closed;

e Field (for Field Management issues): Draft, Open, Work complete, Ready
to inspect, Not approved, In dispute, Closed, Void. [29]

Revit Cloud Worksharing with BIM 360 brings powerful, collaborative Revit
workflows to the cloud. Enable your teams to co-author Revit models in real-time,
staying up-to-date with the latest approved work. Use the best talent for the job,

no matter where they are located. [30]
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Figure 5: Workflow for BIM 360 Clouds. [https://www.autodesk.com/bim-360/bim-collaboration-
software/design-collaboration/revit-cloud-worksharing /]
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1.3 MEP Engineering

The author of this thesis was commissioned to model two MEP plants

characterizing the metro station of Collegno Centro.

MEP is an acronym that stands for mechanical, electrical and plumbing
engineering. These three technical disciplines encompass the systems that make
building interiors suitable for human occupancy.
MEP installations are addressed together due to the high degree of interaction
between them, and also to avoid conflicts in equipment locations - a common
problem when electrical, mechanical and plumbing systems are designed in
isolation. (ny-engineers.com).

Various types of mechanical systems are used in residential, commercial and
industrial buildings. However, three types account for most of the mechanical
design work in multifamily and commercial constructions: Heating, Ventilation
and Air conditioning (HVAC) systems. Nevertheless, some other systems can also
be included like lifts, escalators, or other transposing system. These systems
interact to keep temperature and humidity within a range that provides comfort
and health. Mechanical ventilation also ensures that enough fresh air is supplied
to keep pollutant concentrations at low and safe levels.

Not only power supply but also other systems conform the electrical system.
Among them it can be mentioned telecommunications, control, security,
detection and lightning systems.

Plumbing systems are associated with fluid movement. They can be used for
many different purposes, like water supply, recovery and treatment systems,
water drainage, waste removal, among others.

MEP engineers help in the design stage by providing information about the space
to be occupied by the equipment, since location conflicts are very common. The
use of BIM is strongly recommended during these phases since a good
collaboration with the other teams will result in time reducing and consequently
efficiency improvement. Another added value for MEP design is the use of models
for energy, lightning or mechanical analysis, which allows to optimize the system

design using specialized software, using the less resources possible.
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MEP models may also be useful for operational phases, being conserved as

reference for maintenance activities. [7,8]
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Figure 6: Example of MEP model in Revit. [https://it.geofumadas.com/bim-curso-de-revit-mep-
mecanica-electricidad-y-plomeria/].
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1.4 LOD

In recent years, attention to information management in the construction sector
has visibly increased, also thanks to the continuous development of BIM
applications.

Project management is divided into several phases, ranging from design to
maintenance, and each phase requires a different level of information [10]. LODs,
however, are not defined by the design phases, rather, they can be completion
[11]. The Level of Development, or level of development, or even Level of Detail
(LOD) of the data is defined by the project team and is contained in the Model
Production and Delivery Table (MPDT). The LODs allow to precisely define the
degree of depth of the information contained in the model. International
standards propose different LOD scales. The AIA, American Institute of
Architects, defines LODs as a level of development, because an element that can
appear visually detailed could be generic in reality. In addition, it defines 5 levels
of development:

« LOD 100: the element is represented generically or with a symbol but does not
meet the requirements for LOD 200, and further information on the model
element may be derived from other elements;

« LOD 200: the element is represented with generic quantity, size, shape, position
and orientation, in addition, non-graphic information can also be linked to the
element;

« LOD 300/350: the element is represented with the correct size, position and

orientation and interfaces correctly with the other elements of the model;

» LOD 400: the element is shown with the correct size, position and orientation,
interfaces correctly with the other elements of the model, and reports details
relating to manufacturing, assembly and installation;

» LOD 500: the element faithfully reflects reality, and is a representation verified on site

in terms of size, shape, position, quantity and orientation.

11
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LOMD1 LOMD2 LOMD3 LOMD4 LOMDS LOMD&
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Figure 7: LOD, AIA. [https://evolve-consultancy.com/lod-lod-loi/]

In Italy the legislation that refers to LODs is UNI 11337-4 of 2017, which classifies
them in LOG (level of development of geometric objects attributes) and LOI (level

of development of informative objects attributes).

The Italian law allows the use of any of the existing LOD scales, according to the
specific needs of the contract and provided that specific references, logic,
objectives and structure are defined in advance for the purposes of maximum
transparency for the subjects interested. The LODs represent the amount of
information useful to meet the expectations of the BIM operator in a given design
phase [12]. The UNI 11337-4 standard states that the level of development of a
digital object is measured by the nature, quantity, quality and stability of the data
and information making up the object as defined by the stable and structured
connection of its geometric and not geometric.

Continuing the standard states that these data and information, geometric and
non-geometric attributes, are expressed:

« in graphic form, for three-dimensional virtualization (3D object), possibly
accompanied by specific two-dimensional representations (2D drawing);

« in written and multimedia form, also through the use of specific product and

process information sheets.

12
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Figure 8: Diagram of information links between entities of work digital objects and their level of
development (LOD). [UNI 11337]

Unlike the 5 levels proposed by the ATA, UNI 11337 identifies the LODs through
an alphabetical scale:

« LOD A: the entities are represented graphically through a symbolic geometric
system or a representation of genre taken as a reference without constraint of
geometry. The quantitative and qualitative characteristics are indicative;

« LOD B: the entities are virtualized graphically as a generic geometric system or
an outline geometry. Qualitative and quantitative characteristics are
approximate;

« LOD C: Entities are virtualized graphically as a defined geometric system. The
qualitative and quantitative characteristics are defined generically in compliance
with the limits of current legislation and the reference technical standards and
referable to a plurality of similar entities;

« LOD D: the entities are virtualized graphically as a detailed geometric system.
The qualitative and quantitative characteristics are specific to a defined plurality
of similar products. The interface with other specific construction systems is
defined, including the approximate dimensions for operation and maintenance;
« LOD E: entities are virtualized graphically as a specific specific geometric
system. The quantitative and qualitative characteristics are specific to a single
production system linked to the defined product. The level of detail relating to
manufacturing, assembly and installation is defined, including the specific
dimensions for maneuvering and maintenance;

« LOD F: the objects express the virtualization verified on the site of the specific

production system performed / built. The quantitative and qualitative

13
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characteristics are those specific to the single production system of the product
laid and installed. The management, maintenance and / or repair and
replacement interventions to be carried out throughout the life cycle of the work
are defined for each individual product;

« LOD G: objects express the updated virtualization of the actual state of an entity
in a defined time. The management, maintenance and / or repair and
replacement interventions to be carried out throughout the life cycle of the work
are defined for each product [8].

The information models do not only contain geometric data but are also a series
of attributes (type of elements, materials, characteristics, performances, etc.),
consequently, the model can be characterized by levels of graphic and informative
detail different. In addition, there is also the lack of homogeneity in the definition
and content of the LODs, which varies according to the countries and the
standard used. These considerations led to the introduction of a new definition
"Level of Information Need" or LOIN in the ISO 19650 standard, using a
terminology that underlines and reiterates, on the one hand, the importance of
information contents whatever their nature, from Another requirement is that
the number and type of information contained in the model be limited to what is

actually necessary.

In this thesis the author was asked to model the plants with a LOD C, referring to
the UNI11337.

14



2 Reference standards

To develop this thesis, both modeling and coding, regulatory standards were
followed. In particular, reference was made to UNI EN ISO 19650 and UNI 11337

which are complementary to each other.

2.1 UNI EN ISO 19650
UNI EN ISO 19650-1: 2019 and UNI EN ISO 19650-2: 2019 are the Italian

implementation of ISO, the international standards to refer to in the context of
BIM design. Part 1 provides information and describes the principles for
information management, according to ISO 19650. It also provides a series of
recommendations always related to information management, which include
exchange, registration, updating and organization for the actors involved in the
process. planning. The standard is applicable to the entire life cycle of the work,
including strategic planning, initial design, engineering, development,
preparation of documentation for assignments and construction, daily
operational operation, maintenance, refurbishment, repair and end of life. The
standard can also be adapted to constructions of any size and complexity. Part
two specifies the requirements for the management and exchange of information
during the delivery phase of the work. This part can also be applied to all types of
construction and to all types and sizes of organization, regardless of the choice of
procurement strategy. These international standards apply jointly to UNI 11337,

which is a complementary standard.

2.2 Legislative Decree 50/2016

Legislative Decree 50 of 2016, implementation of directives 2014/23 / EU,
2014/24 / EU and 2014/25 / EU, establishes the beginning of the processes for
the development of new standards, aimed at innovating and integrating previous
provisions in area of digitization. Article 23 paragraph 13 states: "The contracting
authorities may request the use of electronic methods and tools for new works as

well as for recovery, redevelopment or variants, especially for complex works.

15



Reference standards

These tools use interoperable platforms by means of non-proprietary open
formats, in order not to limit competition between technology suppliers and the

involvement of specific projects among designers.

The procedures and times for progressive introduction are defined by decree of
the Ministry of Infrastructures and Transport of the mandatory nature of the
aforementioned methods at contracting authorities, granting administrations

and economic operators ".

2.3 Decree 560/2017

The Italian Decree 560/2017, implementing article 23 paragraph 13 of Legislative
Decree 50/2016, also known as 'BIM Decree', is the reference standard within the
national territory that defines the methods and times for progressive
introduction, as reported in Article 6, of the gradual mandatory nature of
electronic building and infrastructure modelling methods and tools, according to
the following timing;:

« For complex works relating to works with a tender amount equal to or greater
than 100 million euros, starting from 01.01.2019;

« For complex works relating to works with a tender amount equal to or greater
than 50 million euros, starting from 01.01.2020;

« For complex works relating to works with a tender amount equal to or greater
than 15 million euros, starting from 01.01.2021;

« For works with a tender-based amount equal to or greater than the threshold
referred to in Article 35 of the Public Contracts Code, starting from 01.01.2022;

« For works with a tender amount equal to or greater than 1 million euro, starting
from 01.01.2023;

» For works with a tender amount of less than 1 million euro, starting from

01.01.2025;
In addition to the ministerial decree which represents a regulatory reference in

the BIM field, what defines the timing of its introduction is accompanied by the

voluntary (non-mandatory) technical standard, which defines the guidelines to

16



Reference standards

follow in the adoption of this methodology.

2.4 UNI 11337

The UNI 11337 standard is a document divided into ten parts that deals with the
digital management of information processes in constructions and, specifically,
deals with models, documents and information objects for products and
processes, evolution and information development of models, respectively,
documents and objects, information flows in digitized processes. The information
is divided as follows:

« PART 1: models, drawings and objects.

» PART 2: denomination and classification.

« PART 3: [information sheets] LOI and LOG.

« PART 4: LOD and OBJECTS.

« PART 5: management of models and documents.

« PART 6: example of informative specifications.

« PART 7: qualification of figures.

« PART 8: PM / BIM-M.

« PART 9: construction file.

« PART 10: administrative verification.

Among the results of the thesis work, there is an object library; it is important to
report the definition of objects, contained within part 1: objects are the virtual
components, more or less complex, of an information model [9]. In addition, the
objects and / or object libraries are the result of the digitization process of the

report which involves the creation of an information model.
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3 Case study

The Turin Metro (Italian: Metropolitana di Torino) is the modern VAL rapid
transit system serving Turin. It is operated by Gruppo Torinese Trasporti (GTT),
a public company controlled by the municipality of Turin. The system comprises
one 13.2-kilometre (8.2 mi) line with 21 stations connecting Fermi station

in Collegno with the Lingotto multifunctional centre in Turin.

Two additional stations, reaching the Southern boundary of the city, are currently
under construction. These stations will be known as Italia '61, serving the
new Piedmont Region Headquarters, and Bengasi, named for the piazza under
which it will be located. Recent estimates suggest this southern extension will be

completed not before February 2021.

A further Western extension is planned to reach the boundaries of Collegno and
the city of Rivoli. In December 2017, the city approved the first stage of the
project, valued at €123.7 million, to construct two already named stations:
Certosa, which will interchange with the central railway station of the city of
Collegno, and Collegno Centro, serving its central market area. An additional two
stations, including one in the Leumann Village neighbourhood and another in the
Cascine Vica district of Rivoli, were allocated €148 million.[13] The Ministry of
Infrastructure and Transport expects the extension to Cascine Vica to be

completed by Summer 2023. [24]

The first functional lot Fermi-Collegno Centro of the West extension of the Line
1 of the driverless metro of Turin represents a first part of the natural extension
of the section Collegno — Porta Nuova — Lingotto — Bengasi, with a design that
develops entirely underground. It extends in total for about 1,75 km. The station
design was carried out taking into consideration the intention to standardize the
station typology by implementing criteria that have guided from the beginning
the development of Line 1. The project has been fully developed in BIM field,
allowing the coordination of the different interfaces that contribute to the

geometries definition to guarantee uniformity, control and coherence of the
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Case study

functional design with other design disciplines (architectural finishes, structures
and facilities). Stations design transposes assumed and adopted guidelines both
for the operational section and for the one under construction in a way that
guarantee an aesthetic coherence and a homogeneity from the point of views of
volumes, transparency and architectural. In this sense, the main adopted
criterion into the executive design is to use characteristics and kind of details
already used for other stations of the Line 1 in order to maintain a sense of

continuity and unitarity into the spaces definition, the interior architecture, the

lighting and materials choices. [9]

Figure 9: Map of the Turin subway.
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3.1 System design

Executive design of non-system installations, both for stations and line, takes into
account the different related systems: ventilation and air conditioning systems,
water and fire protection systems, electric systems, fire alarm systems and special
systems (mobile ladders, elevators, automated ticketing and gate control,
advertising). Respect to the definitive design has been adopted different
technologic improvements taking into consideration standards updates following

the approval of the design. [9]

Figure 10: Collegno Centro station.

3.2 Ventilation, air conditioning and fire system

The work done in this thesis revolves around the systems of ventilation and air
conditioning (HVAC) and fire of the Collegno Centro station. The all work is been
made under the supervision of the Geodata S.p.A. of Turin that has already build

structural and functional models used to coordinate the MEP systems.
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4 Methodology

In the following figure it is shown a sort of flowchart that explain the
methodologic process used to complete this thesis. In particular as inputs have
been used plans of structural, functional and systems in editable form (.dwg file)

and not (.pdf file), and also .rvt file of structural and functional models.

The internal process involved the creation of a code made by .xIsx file in order to
name both documents and MEP elements within models but also the building of
the models themselves with the definition of families. As part of this phase there
are also the modelling of the entire air ventilation and conditioning and fire

systems.

As outputs it is been obtained the IVC, ventilation and air conditioning systems,
and ITA ,fire systems, models within Revit and clash detection verifications
comparisons between different sotware, in particular: Revit, Navisworks and
BIM360 (Coordinate set).
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5 Information production

The information production process in a BIM design consists in the creation of
the Building Information Model. The task assigned to the author of this thesis
was to create MEP models.

The information production process is generally ruled by a BIM Execution Plan

(BEP) that is the response from the contractor company to the contracting one.

To make this thesis, one of the BEP aspect studied was the name coding of
documents and single parameters used into the project as you can see into the
following tables. The first coding constructed concerns the one related to the
documents name:

Table 1: Documents code table.

Level Description N" of characters
1st level | Reference to te contract B MTLIT3
2nd level Batch 2 AD =General contract
Ax =batch x
3rd level Waork phase 1 F =Preliminary
D = Definitive
E = Executive
I = Integrative
C = Constructive
4th level Sub-design 3 IMP = Non-general system installations

IEL = Electrical systems
IWC =Ventilation and air conditioning systems
IIA =Fire and sanitation systems
IRl = Fire detection systems
IFD = Sound/data systems
ISP = Special systems

5th level WBS Civil Engineering work 3 SCC = Collegno Centro Station
oth level Documents type 1 R =Report
S = Graphic elaborates
K =5cheme

T=Planning table
C =S5tetament, econimic assessment
E =Price list
A =Price analysis
Z =Technical specifications
V =Various
7th level Progressive number 3 00n
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After having decided the general naming code for documents, another naming

code was built for naming every single element within models.

Table 3: : Code for single elements within IVC and IIA models.

Level Description N® of
characiers
It level Company 2 D = GEODATA
2nd level Sub-discipline 1 Vo= WVENTILATION
P = PLUMBING
3rd level Object category 2 WD = VENTILATION DUCT
GR = GRID
CHN = CONNECTION
DP = DAMPER
DF = DIFFUSER
PP = PIPE
41 level Object characteristics 2 On = n® air flow
SW = Sanitary Water

Table 2: Code for ventilation elements.

VENTILATION GO VE\N(E'{QI\T,I':%N GRID:GR (=R consf(m‘;nm: [GD][C_ggg[C.]%IE“lI\lET]H\]EE]MIW DESSUEEETFEN w%ﬂﬁg'ﬁﬁn
(DESCRIPTION) PRICE LIST
YENTILATION E Y GR 0 GRO1 B0-Y-GR.01_250x150 250750
YENTILATION G0 i GR 0 GR.OT G0-Y-GR.01_300:100 300300
YENTILATION E Y e 0 GRO1 B0-Y-GR.01_300x150 00750
YENTILATION E Y e 0 GRO1 BO-Y-GR.01_350:200 30x200
YENTILATION E Y GR 0 GRO1 B0-Y-GR.01_400x150 400750
YENTILATION G0 i GH 0 GR.OT G0-Y-GH.07_400x200 400200
YENTILATION E Y e 0 GRO1 B0-Y-GR.01_450x150 450750
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At this point it is obtained a code for each element built into the model.
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5.1 MEP modelling within Revit

Revit is BIM software widely used by architects, engineers, and contractors to
create a unified model that all disciplines and trades can use to complete their
work. Autodesk Revit was created to support BIM and not to replace BIM. Revit
hosts the information that forms the model from which drawings and documents
are derived.

Some recommendations for creating the model were taken from the AEC BIM
Protocol for Autodesk Revit. This is a unified standard for the AEC industry that
also includes a checklist that helps the modeller make sure that the work was done

as required in the standard.

In the System tab, MEP families are divided by main sub-disciplines: Heating
Ventilation and Air Conditioning (HVAC), Mechanical, Plumbing & Piping and
Electrical. This split of user interface allows to identify more easily the MEP
objects to upload in the model. Under each sub-discipline, the MEP objects can
be Loadable families such as Air terminal and Plumbing fixture, or System
families such as Duct and Pipes. Moreover, the Systems tab includes P&ID

Modeler, a panel for the advanced modelling.

Architecture  Structure Steel Systems  Insert  Annotate  Analyze  Massing & Site Collaborg

b;[:j Fﬁ:ﬂ] 19

Duct Duct _A'_ Flex Air Fabrication P&ID Modeler Mechanical
Placeholder _[J] ~ Duct Terminal Part Equipment
HVAC ] Fabrication ¥ P&ID Collaboration ¥ Mechanical =

rate  View Manage Add-lns  Modify &~

QL ETLEFr YD ES ¥ B

Pipe Pipe Parallel Plumbing Sprinkler  Wire Cable Conduit Parallel 5 Electrical Device Lighting
Placeholder Pipes R Fixture M Tray Conduits Equipment M Fixture
Plumbing & Piping ] Electrical ]

Figure 11: Revit System tab.

Like the Architectural model, the MEP model can also be created starting from a
specific Template file with predefined settings based on the sub-discipline.
Regardless of the template chosen, the software allows to model objects belonging

to several disciplines within a single project file. Views can be organized based on
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the “Disciplines” parameter within the Project Browser; when the Discipline
property is set to Mechanical, Electrical, or Plumbing, the objects that do not
belong to MEP categories are visualized halftone. In order to start the MEP
modelling, it is fundamental to customize the Mechanical and Electrical settings.
Opening the Mechanical Settings dialog starts from clicking the lower-right arrow
of HVAC, Mechanical or Plumbing & Piping panel. Alternatively, click [Manage
tab > Setting Panel > MEP Settings drop-down > Mechanical Settings]. In this
tab, it is possible to set some properties of ducts and pipes, such as the fitting
angle, the segments and sizes, the calculation methods, etc. It is fundamental to
set these parameters before starting the modelling because it allows to customize
specific settings of the project. The fundamental feature that makes MEP families
different from other disciplines is the concept of Connector. In order to create a
component belonging to system topology, the MEP object must get one or more
connectors. The discipline assigned to a connector determines the systems types
of belonging and how it will interact with other system components. Each family
can have one or more connectors, belonging to the same or different disciplines,
listed below: Electrical Connector, Duct Connector, Pipe Connector, Cable Tray
Connector, Conduit Connector. A conduit connector can be an individual
connector or a surface connector. The individual connector is used for connecting
only one conduit. The surface connector is used for connecting more than one

conduit to a surface.

The Loadable Families can be loaded from existing objects libraries or customized
by creating new families. In order to create a new family of a component
belonging to system topology, it is fundamental to start opening an adequate
template. For this purpose, it is necessary to choose template system categories.
When modelling is completed, adding a connector on an object surface is
possible. Within a MEP model, System Families are used too, such as Ducts, Pipes

and Conduits.

They link terminals and equipment, horizontally and vertically. In order to
connect the system pipes with their fittings, it is necessary to specify the Routing

Preferences for every type of duct. Once the element is selected it is necessary to

27



Information production

click [Edit type > Edit in the Routing Preferences row > Load Family of fittings

useful in the project > Select correct fitting family in the drop-down tab in Pipe

Segment > Select Pipe sizes to apply the fitting selected > OKk]. After this

customization, the fitting between two pipes will be created automatically, as

defined in the Routing Preference tab.

Modifying the attributes in Routing Preference tab, the pipe fittings do not

change for existing pipes. The same procedure must be applied for ducts and

conduits.

Routing Preferences

Pipe Type: Default

— M_Gomito - PVC - Sch 40: Standard

‘Segmems and Sizes... | | Load Family...
t- Content Min. Size Max. Size | *
- : :
Steel, Carbon - Schedule 40 15000 mm 600000 mm

M_Raccordo a T - PVC - Sch 40: Standard

M_Croce - PVC - Sch 40: Standard

M_Riduttore - PVC - Sch 40 - DWV: Standard

M_Innesto - PVC - Sch 40 - DWV: Standard

M_Calotta - PVC - Sch 40: Standard

Figure 12: Routing Preferences for IIA system.
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Every MEP component can be a part of a system. When a system component is
selected, it is possible to choose a system of belonging, based on the types of

connectors applied within the family.

Regarding the mechanical systems, it is possible to create a specific HVAC system,
based on the System Type assigned to the Duct Connector in the component

family: Supply Air,

Return Air, Exhaust Air. First, it is necessary to place air terminals and
mechanical equipment in the model. By adding ducts to connect the components,
they are automatically assigned to a system. Another way to create a mechanical
system consists of selecting the components and manually adding them to a

system. The same procedure is used to create

a Piping System. The system of belonging depends on the System Type set in the
Pipe Connectors properties. Once fixtures are placed in the model, a system can

be created by connecting automatically the components through pipes.

5.2 Templates

Before starting a new project, the Revit modeller asks for a project template file
to be opened. The project template represents the starting point of the new
project model. It includes view settings, load families and defined settings. They
are saved in an RTE extension file. When IFC links were loaded they displayed in
halftone mode, as it was preconfigured in the view of the System template. For
the purpose of the thesis it is used the same template used in the already existing

structural and functional models to be coherent with the whole design. [26]

5.3 Levels

Starting from the levels existing into the structural and functional models other
three main levels have been added. They are called “Inferiore”, “Mezzanino” e

“Superiore”. Gradually all elements are linked to the three levels.
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Figure 13: Levels related to the system models.
5.4 Linking files

In order to have all models together, it is sufficient to link the modelled ones into
the current Revit project. To do it is possible to use the link tab into the insert
panel. The same procedure it has been used to link Cad files of the design,
necessary for the modelling phase. In this way it is maintained a connection
between the file and the model, so the file it is used as un underlay or it is included

in the construction documentation set.

30



Information production

5.4.1 Linking Revit
RCHG-0-7- @ 2-FO0A G- %I
Architecture  Structure  Steel  Systems  Insert  Annotate  Ana

b RIS & @ &

Modify| | Link | Link | Link DWEF Decal Point Coordination Manage |
Revit | IFC | CAD | Markup N Cloud Model Links

Select - Link

Figure 14: Revit linking possibilities.

To be coherent with the already existing models of the subway station it has been

chosen to link Revit models with shared coordinates.

The reference type of linked files is very important because it will then determine

how that link behaves in the new model.

Attachment

Lmk Link
Refﬂfﬂce type: Reference type:
Attachment Any
Project B Project C now
contains Projects A contains
Projects B and A
Overlay
Lmk Link
Refer ence type: Reference type:
Overlay Any
Project B Project C contains
contains Projects A

only Project B

Figure 15: Difference between reference type. [https://revitiq.com/attachment-vs-overlay-revit/]
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In the Attachment case both project B and A will be visible into project C, for this

reason this option is been chosen within the project.

5.4.2 Linking CAD

Project elaborations are provided among the input data. The next step was to
connect the files in . dwg format to the template. First of all, plant views were
created in Revit by clicking on View > Plant views > Floor Plant, so a window

appear that permit to create a floor plant for each level.

Mew Floor Plan >
Type

Floor Flan b Edit Type...

Select one or more levels for which you want to
create new views.

00_SOTTOBANCHINA
01_BANCHINA
02_MEZZANINO
03_ATRIO

A_TOP VENTILAZIONE
A_VENTILAZIONE
C_TOP VENTILAZIONE
MAX

SUPERIORE

T

T11

T12

T14

T15

T16

T20

[ ]Do not duplicate existing views

0K Cancel

Figure 16: New floor plan.
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Identified the plan view of the floor plan relative to the ventilation and air
conditioning system, once created the relative floor plan view, it is passed to the
linking of the CAD file. Revit allows, having chosen the file to be linked, to select
the level to which to insert, the scale, to choose the positioning and to select or
not some layers. For convenience, the Current View Only option was selected, so
that the linked file is visible only in the plan view to which you want to link it and
not in all the others. As well as importing a CAD file it is also possible to link it,
the difference between importing and linking a file is that with the first option the
inserted file is updated every time it is modified, even after being inserted in the
project, while with the option imports if the CAD file undergoes changes after
insertion, no automatic update happen. Linking or inserting a CAD file into the

project is very useful and allows us to quickly position the elements of the model.

5.5 Object creation

Once links are loaded, the next step is to start modelling. The right way for
modelling MEP equipment is to first locate the terminal families in the right
place. Then, pipes or duct layout is created. In the next paragraphs the
methodology employed for creating the Revit models is explained.
Firstly, it is important to introduce some new concepts. Every object created on
Revit is technically called “instance”. Each instance corresponds to a hierarchical
classification inside Revit that consists on: Categories, Families and Types.
Categories represent the most general classification. Some examples of category
are Pipe, Pipe Fitting or Mechanical Equipment. Depending on the category, a
property set for each instance will be provided. Within Revit there are three types

of families:

e System Families: They are always available in any project; it is impossible
neither to remove them nor to load an own version. This is the case of pipes
or air ducts into the project.

e In-place Families: Created in the Revit project directly, they cannot be
saved as a separate file and they cannot have different types. For this

project few families have been created in this way.
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e Loadable Families: These are the most common ones. They can be found
on the Revit libraries, on the internet or be designed from scratch at the
Family Editor. They are saved with RFA extension as separated files, and

they can be also loaded in other projects.

Families have their own “Families parameters”, which depends on the category
they are part of. Some of them, nevertheless, are common to every category like

» «

“always vertical”, “shared” or “Identify Data parameters”.

Subdividing families into types is very useful when standardized objects with
different dimension or properties are needed. What make the difference between
family types are the “type parameters”, while at the same time, every type shares
the same standard parameters of the family, such as Material, Model;

Manufacturer and so on.

FAMILY
]
TYPE ‘ TYPE
| |
I | I | I I
0 O o g U o
INSTANCES INSTANCES

Figure 17: Hierarchical structure of Revit objects.
[https://revitpure.com/blog/33-weird-revit-terms-
explained]

Lastly, instances represent the single object placed in the project. They adopt the
property set of the category the correspond to, as well as the family and type
properties, but that is not all: They can also have instance project parameters.
These parameters can be completed into the property panel, when a certain

instance is selected.
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5.5.1 Family Editor

The family editor is a tool inside Revit which has an easy access by double-clicking
in a loadable family or by left clicking and selecting the “edit” option. It is desired
to start sketching a new loadable family, the way to do it is by clicking on File >
New > Family.
When a new family is created from scratch, similarly to new projects case, a
window asking for the starting template is asked. There are many templates
according to the host and family category. It is not recommended to use hosted
families, most of the families were created starting from the generic template.
However, it must be said that selecting the template is a point of no return: if it is
desired to model a face-based family, it must be picked the face-based template.
Else, the family would require to be modelled again.
The next step is to pick the category to which the family will take part. Failing in
this step is not a problem since it is always possible to change it.
When starting to create the family, the modeller should pay attention to some
standards and recommendations for the type desired. They are not strict rules but
the result of years of experience of specialist modellers. Some of them are written
below:

e Avoid using Speciality equipment Category;

e Use Lookup tables rather than creating separate families;

e File size: No more than 400KB for single objects and 800KB for more

complex ones.

They have been taken from the Revit Model Content Style Guide from

Autodesk and the European MEP Content Standard.
Altimetric position
The rest of the information about MEP equipment received consisted on a CAD
section of the platform, information taken from the general and evaluation report

and the answers to some questions made by phone call to the company’s designer.
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5.5.2 Duct accessories

The most numerous parts of the library of modelled objects consists of accessories
for the ducts. All families have been created from a new model, except for the
family of damper shutters and for the one of grids.

The family most present in the ventilation model is that of the joints; joints are
connecting/joining elements between two channel segments.

To make the elements connect to the two duct sections, connectors have been
inserted on both sides. Connectors are those elements that differentiate the MEP
model from the architectural and structural one. In fact, each element belonging
to an installation is equipped with at least one connector.

The couplings were created as a new family from a generic metric model, once
inserted the connectors and classified as duct accessories, were loaded into the
project.

Although the family has been created with parametric dimensions, which allow
to adapt the joints to any duct, as the dimensions of the connectors have not been

parameterized, a family has been created for each dimension.

This was an initial error due to the author’s little experience with the software.
Subsequently it was chosen to have a single family with a parametric size
connector, so as to have more types of elements of a single family, as for the

supports for ducts.
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Project Browser - MTL1T3_A1_E_IVC_SCC_...
Mass
= Mechanical Equipment
= GD-V-CN.01_01
GD-V-CN.01_500x300
= GD-V-CN.01_02
GD-V-CN.01_02_500X250
GD-V-CN.01_02_550X300
GD-V-CN.01_03
GD-V-CN.01_03_1150X600
GD-V-CN.01_04
GD-V-CN.01_04_500x300
GD-V-CN.01_05
GD-V-CN.01_05_600x300
GD-V-CN.01_06
GD-V-CN.01_06_650x350
GD-V-CN.01_07
GD-V-CN.01_07_750x400
GD-V-CN.01_08
GD-V-CN.01_08_800x400
GD-V-CN.01_09
GD-V-CN.01_09_800x1000
GD-V-CN.01_10
GD-V-CN.01_10_850x450
GD-V-CN.01_11
GD-V-CN.01_11_900x450
GD-V-CN.01_12
GD-V-CN.01_12_950x500
GD-V-CN.01_13
GD-V-CN.01_13_1000x500
GD-V-CN.01_14
GD-V-CN.01_14_1050x%550
= GD-V-CN.01_15

[ e [ [ [ [ [ e [ e [ [ [T e 1]

Figure 18: Project browser, Reuvit.

In the families section of the project browser, clicking on the "+" you can see all
types associated with each family. To change the size of the element, once
inserted, just click, selected the object, in the property panel on Edit Type and
choose the size of the drop-down menu.

If the required type is not available, by clicking on the Duplicate button you can

create it.
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Type Properties hd
Family:  GD-V-CN.01_02 v| Load...
Type: |GD—U—CH.01_02_550)C100 w | Duplicate...
Type Parameters
Parameter Value ="

Default Elevation

1.2192

H 0.0100
L1 0.5500 ]
L2 0.3000 ]
L3 0.3500 ]
L4 0.3000 ]
6 0.2000 o

Classification

‘None

Type Image

Keynote

Maodel

Manufacturer

Type Comments

What do these properties do?

<< Preview

OK

Cancel

Apply

Figure 19: Type properties, Revit.
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Figure 21: Junction with connection, Reuvit.

Figure 20: Different families used into the IVC model.
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5.6 LOI and LOG

Information, as seen in the paragraph dedicated to LODs, plays an important role
in a BIM project. The level of information more commonly indicated by the
acronym LOI (Level Of Information), is used to indicate all the non-geometric
information content of a family. A family with a high level of information may
include, for example, manufacturer specific data sheets and instructions
regarding maintenance. The parameters allow us to enter information within a
project. In Revit, it is possible to create custom parameters for a project and for
any category of elements or components within it. The parameters created are
visible in the type properties dialog box or in the properties palette, depending on
whether they are of type or instance, in the selected group. There are different
types of parameters:

« Global parameters;

« Shared parameters;

« Project parameters;

« Family parameters.

Global parameters are parameters specific to a single project, but are not
associated with any category, they can be simple values, values obtained from
equations or even parameters derived from the model by means of other global

parameters.

Shared parameters are definitions of parameters that can be used within multiple
families and projects. After inserting a new shared parameter, you can use it as a
family or project parameter. The definition of a shared parameter is stored in a
separate file and as a result, the shared parameter is protected from changes. For
this very reason, shared parameters can be labelled and included in schedules. A
schedule is a collection of information extracted from the properties of elements
in a project and displayed in a table. Revit schedules are extremely useful tools
and it is possible also to export them to other programs, such as a spreadsheet.
You can create a schedule at any point in the process design. When changes are

made to the project that affect the schedule, the latter is automatically updated.

The project parameters are also, like the global parameters, specific to a single
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project. The information contained within this type of parameters cannot be
shared with other projects but can be used for the creation of schedules, for their

ordering and for the creation of filters.

Family parameters are family specific settings, they can be also used for the
control of parameters of nested families, associating the parameter of the host
family to the parameter of the nested family. For creation the same procedure was

followed for each parameter:

e Create shared parameter: go to Manage and click on the shared
parameters icon. Once the shared parameters editing tab is open, click on
New and create the desired parameter, and finally insert it in the category

of interest.

Edit Shared Parameters X

Shared parameter file:

C:\Users\gabri\Desktop\Tesi\STAZIONE Browse... Create...

Parameter group:

wC i

FParameters:

Parameters
Flow

Velocity Newy...
Properties
Move
Delete

Groups

Mew...
Rename...

Delete

Figure 22: Edit window for shared parameters.
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e Create project parameters: go to Manage and click on the project
parameters icon. Clicking on Add opens the window shown in the figure

below.

Parameter Properties s

Parameter Type
@Project parameter
(Can appear in schedules but not in tags)

(") Shared parameter

(Can be shared by multiple projects and families, exported to ODBC, and
appear in schedules and tags)

Select Expor

FParameter Data

Name:

[ | Otype
Discipline: @Instance
Common e

Type of Parameter: Values are aligned per group type

Length ~ Values can vary by group instance

Group parameter under:

Categories

|:| Hide un-checked categories

[] Air Terminals

[] Analytical Beams

[l Analytical Braces

[ Analytical Columns

[] Analytical Floors

[l Analytical Foundation Slabs
[[] Analytical Isolated Foundati...
[] Analytical Links

[ Analytical Nodes

[l Analytical Pipe Connections
[] Analytical Spaces

[ Analytical Surfaces

[l Analytical Wall Foundations
] Analytical Walls

[ Areas

[] Assemblies

[] Cable Tray Fitings
[l Cable Tray Runs

Dimensions L

Tooltip Description: M rakhla Trawve hd
<MNo tooltip description. Edit this parameter to write a custom tooltip. Custom tooltips ha... < >
Edit Tooltip... Check All Check None
Add to all elements in the selected categories
OK Cancel Help

Figure 23: Parameter property, Reuvit.

Select the Shared parameter option and choose the shared parameter just
created. Depending on the parameter, choose whether to attribute it to the type
or to the instance and to which elements to assign it. If you select the Type option,
the parameter is entered in the properties of the type and its value can be changed
in the Edit type window, if you choose the Instance option, the parameter appears

and can be changed in the Properties panel.

In order to avoid having different parameters names among the different model
files, it is crucial to used “shared parameters”. Having different names or field
types for parameters would generate important issues, like no being able to
schedule them in the federated model. This concept improves information

consistency.
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Shared parameters can be used in multiple families and projects. These types of
parameters are saved into a XLSX extension file in which it is been specified the
Name of the parameter, the Parameter group, the Group, the Type and the Unit
of measure. For the purpose of this thesis, a unique file was created were
parameters were divided into groups.

Table 4: Table of shared parameter used for IVC model.

Flow IVC Mechanical Instance [ma/h]
Velocity IVC Mechanical Instance [m/s]

As regards, instead, the creation of family parameters, the path that has been

followed is divided into two phases:
1. Create shared parameter (as for project parameters).

2. Create family parameter: open the family to which you want to associate the

parameter, click on the Family Types icon and create the new parameter.

The outside, the visible part of the represented elements, is the Level of Geometry.
It tells us something about the appearance of the element. The LOG in a BIM

model expresses the geometric level of detail.

For the MEP models build with this thesis, the customer had requested a LOD C,
but the final models realized was modelled with a higher LOD to understand the
actual interference. In fact, looking at the UNI 11337, a LOD C for a MEP system
includes from a geometrical point of view just a conceptual and generic
representation of the spaces of the main overall dimensions of the pipes
(technical tunnels) and has as characteristics just the definition of the main paths
within the technical tunnels as it is possible to see into the table in the following
page. While in the developed models the LOD results higher because, from the
geometrical point of view, ducts and pipes have real dimensions, form the
information point of view, they have specific parameters, like the ones in Table 4,

that characterize them as reported in the design files.
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Figure 24: Detail of the modelled fire system.

Figure 25: Detail of the air ventilation and conditioning
system.
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6 Results

6.1 Ventilation and air conditioning system

In conclusion, at the end of the modelling phase, an information and three-

dimensional model of the HVAC system was obtained, based on a library of

parametric objects, to which a certain amount of useful information was assigned.

Figure 26: 3D view of IVC model.

Figure 27: 3D view of IVC, STR and FUN models.
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Figure 30: Lateral view of the model, Reuvit.

Figure 29: Front view of the model, Revit.

Figure 28: Top view of the model, Revit.
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Results

6.2 Fire system

Successively, at the end of the modelling phase, an information and three-
dimensional model of the HVAC system was obtained, based on a library of

parametric objects, to which a certain amount of useful information was assigned.

Figure 31: 3D view of IIA model.
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o

Figure 33: Lateral view of the model, Reuvit.

3
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Figure 35: Front view of the model, Revit.
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Results

As it is possible to notice in the previous figure, some pipes of the fire system have
been highlighted in red. Indeed, during the build of the IIA model the author
noticed that there were some clashes between the already build ventilation and
air conditioning model and the fire one. So, it has been decided to highlight in a
different colour all that pipes that differ from the original design position in order

to avoid clashes between models.
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7 Clash detection

Clash detection is one of the most fundamental part of the whole BIM modeling
process. Once the designers have finished their work (according to several
disciplines) it is necessary to proceeds to the next step in the BIM process that is
defined clash detection, which is the process of finding where the elements of the
models intersect. The software can highlight when the elements of separate
models occupy the same space and detect in general, the geometrical interference
between elements that belongs to several disciplines. It is a decision of the user
to set the different rules and tolerance according to a level of severity of the clash.
Finding these inconsistencies is vital, as they would severely impact the
construction process, causing delays, design changes, materials costs and a

cascade of headaches and budget overruns. [15]

Only after the models were federated (models are over-lapped: typically, the
models are architectural, structural and MEP models) performing the collision is
evaluable. The report of the collision will be communicate by the BIM manager
to the all BIM coordinator. After that the design team decide who has to change
the model.

51



Clash detection

7.1 Revit

Performing a clash detection is recommended to used linked models (for

instance, the architectural model could be used as “container” in which linked

structural and MEP model).[14]

This can be done following the menu Insert and going through Manage Link.

After the linking phase, the Interference Check can be performed with Revit.

The Clash can be performed for the same elements (the detection of duplications

or interference between levels of, such as walls) or between different discipline

and categories (for instance, wall and ducts, walls and beams, beams and pipes).

Manage Links X
Revit  IFC CAD Formats DWF Markups Point Clouds
: ¥ Reference | Positions
Link Name Status Type Not Saved Saved Path Path Type
MTL1T3_A1_E_FUN_SCC_V_001.rvt Loaded Attachment AAT-FUNVMTLIT3_AT_E Relative
MTL1T3_A1_E_IVC_SCC_V_001.rvt Loaded Attachment AWCWMTLIT3_AT_E_IVC_Relative
MTL1T3_A1_E_STR_SCC_V_001.rvt Loaded Attachment AAO-STRAMTLIT3_AT_E_Relative
< >
Save Positions Reload From Reload Unload Add... Remove
Manage Worksets
Cancel Apply Help

Figure 36: Manage Links, Reuvit.

52



Clash detection

Interference Check

Categories from

Categories from

\ MTL1T3_Al_E FUN_SCC_V_001.rvt

Current Project

Ceilings

Columns

Curtain Panels

Curtain Wall Mullions

Doors

Duct Accessories

Floors

Furniture

Generic Models

Lighting Fixtures

Plumbing Fixtures

Railings

Ramps

Roofs

Specialty Equipment

Stairs

Structural Columns

Structural Foundations

Structural Framing

Walls

Windows

Selection

L] Pipe Fittings

Selection

All MNone

Invert

all None

Invert

0K

Cancel

Figure 37: Interference Check, Revit.
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Interference Report
Group by: Category 1, Category 2

Message 2

=l Floors

MTL1T3_A1 E FUN_SCC W 001.rvt : Floors : Floor :

GD-A-FL.02_100mm : id 699672

-------- Pipes : Pipe Types: Default : id 620331
H Floors

H Floors

H Floors

H Floors

H Floors

H Floors

H Floors

H Floors

H Floors

H Floors

H Floors

H Floors

H Floors

H Floors

H Floors

H Floors

H Floors v

(|
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(|

(|

(|

(|

Created: lunedi 23 novembre 2020 19:47:35
Last Update:

Note: Refresh updates interferences listed

Show Export... Refresh Close

Figure 38: Interference Report, Reuvit.

First limit: the clash detection can be performed into Revit only between two
models each time. This could be overcome if the modelling phase will be done
only in a unique model. But if the file size does not allow it (suggested 250 Mb

each file), it is recommended to separate the models.

Second limit: is not possible to establish in Revit a tolerance for the clash
detection. For instance, if two elements do not intersect but only associate by a

side, Revit will detect a clash and it is not correct. When the clash is confirmed,
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Revit report a list of clashes that can help to visualize the elements.

7.2 Navisworks

In this step a clash detection verification is made using
Navisworks software. Navisworks allows users to open
and combine 3D models; navigate around them in real-
time; and review the model using a set of tools including

comments, redlining, viewpoint, and measurements. A

selection of plug-ins enhances the package adding

interference  detection, 4D time  simulation,

photorealistic rendering and PDF-like publishing.

To export the model from Revit it is necessary to use the external tools into the
add-ins tab make sure to disable the analytical before exporting, then open

Navisworks.

ReEBO -G-7-8 =-FO0A @-0 O, 8- = Autodesk Revit 2019 - STUDENT VERSION - MTL1T3_A1_E_IIA_SCC_V_001 -

Architecture  Structure  Steel  Systems Insert Annotate  Analyze Massing & Site  Collaborate  View Manage Add-Ins  Madify

bR & B e @B e F

Modify| | External | Batch Print Transmit a model About Check Manage & About.. Launch WSM Convert RFA  About Formlt
Tools to Formit
Select + | Navisworks 2019 H eTransmit Model Review WorksharingMonitor Formlt Converter

|
Navisworks 2019

Navisworks SwitchBack 2019

{3D} X

Properties

File exporter for Navisworks 2019

Figure 39: Revit external tool.

Once open the .nwc file within Navisworks a test is added with specific rules like

the tolerance and the type of clash as it is possible to see in figures below.

Clash Detective & X
There are currently no dlash tests defined. (3 Add Test | 53
Add Test
‘ Rules ‘ Select ‘ Results | Report ‘ Create a new dash test.
- Selection A \ - Selection B
Standard Standard
MTL1T3_Al E_IIA_SCC_V_D01_03.nwc MTL1T3_Al E_HA_SCC_V_D01_03.nwc

Figure 40: First step to add a test within Navisworks.
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Clash Detective X

Test 1 Last Run: <None>
Clashes - Total: 0 (Open: 0 Closed: 0)

Name Status Clashes I New | Active l Reviewed l Approved Resolved
Test 1 New /] 0 0 0 0 0
I [ Add Test ‘ I Reset Al ‘ Compact Al ‘ Delete Al ‘ I@. Update Al [r
Select | Results | Report
- Selection A 1 Selection B

Standard ~ Standard ~

[EAVAES

o) (]

CHREE | .[9‘/

~ Settings
Type: | Hard v | Tolerance: |0.050 m
Run Test
Link: | None v | Step (sec): 0.1 ‘ un es ‘
Composite Object Clashing
< >

Figure 41: Test settings.

The clash detection can be performed also with elements belonging to the same

models.

Automatically the software allows to visualize all the interference and produce

several images to visualize the collision between elements.

After running the test, it is possible to check the results in Navisworks with details
about the clash and auto focusing on the clashed elements if present.

For what concern the fire system there are no clashes identified.
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Test 1 Last Run: lunedi 26 ottebre 2020 09:5237

Cashes - Totak 0 (Open: 0 Closed: 0)

st | clubes | [new | [acve

I T O T S S N

| B agoTest | | Resetat | Compacthl | Deetesr | &~

Rules | Select | Results | Report

([3nersee Srene + [B]e) [@ et
e

X(35)-¥(-32) : 03_ATRIO (322)

Figure 43: IIA clash detection test.

In order to check clash detection between different models, it is needed to add

those models within Navisworks and make different tests.

Autodesk Navisworks Manage 2019

Viewpoint  Review  Animation View Output BIM 360 Render
| | &2 Refresh % dj_ﬂy E I__Ig‘h Find Items
> ﬁ Reset All.. ~ Quick Find Q
Append ’ Select Select . _|Selection =
*  |[@ File Options - A Tree |[@lsets ~ &2
| ':] Append it Select & Search ~
i + PP
|j|1‘ Append (Ctrl+A)
Mer
o+ Adds geometry and data from selected files to the current 3D

] model or 2D sheet. Appending retains duplicate content, such as
geometry and markups.

Press F1 for more help viewed Approved Resolved

Figure 42: Add other models to make clash detection verification.

In this way clash detection verifications between single models themselves, ITA
and IVC, ITA and functional model (FUN), ITA and structural model (STR), IVC
and FUN, IVC and STR have been conducted. For what concern clashes between
MEP systems solutions have been found like in the case show in the figure below
where a pipe of the fire system intersects a duct of the ventilation system. In this
specific case the solution adopted solve the intersection bringing the pipe under

the duct considering the space needed between the two for maintenance issues.
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X(1)-¥(3) : INFERIORE (291)

Figure 46: Case of pipe intersecting a duct.

Figure 45: Solution found to the intersection.

After solving this issues Navisworks find zero clashes between IIA and IVC
systems.

Chash Detective.

o=
Test 1 Last Run: luned] 26 ottobre 2020 11:28:15
C T

0 (Open: O Closed: D)

— stats | Coshen | [iee | Jacthe P I — e

I = N O o o | |
B acaTest | | ResetAl | CompactAl | Delete s 2 -
Rules | Sesct | Resuits | Report

[ §New Group Nane ) o | |2 Re-run Test
Nan @6 st 1 Griaint. F Approved... Approved

Bl x(01):¥(43) : 03_ATRIO (358)

Figure 44: Clashes between IIA and IVC models.
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There are many clashes between system models and structural and functional
ones. In the majority of them is sufficient to create a hole in the wall giving the
possibility to pipes and ducts to pass through the walls, but it is important to be

careful in case of reinforced concrete elements because maybe in this cases it’s

better to find another path for the systems.

Figure 47: Intersection between IVC and FUN models.

Figure 48: Intersection between IIA and FUN models.

59



Clash detection

Figure 49: Intersection between ITA and STR models.

Using Navisworks, the clash detection has got an improvement compared to the
clash detection performed previously in Revit, because it is possible to set the

tolerance.

Sometimes is better to set the tolerance to some centimetre (2 - 5 cm ) because
going down to this precision is not necessary, especially during the building

process.

The final report could be visualized internally to Navisworks or externally via

.html or other kinds of interoperable formats. [16]

Figure 50: Export Report and Reports Result. [https://www.bim-hex.com/single-
post/2018/04/09/Best-practice-for-Clash-Detection]
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7.3 BIM 360 Coordinate

Once clash detections have been verified with Navisworks,
it has been decided to make a comparison with another
Autodesk family software: BIM360, in particular using the
Coordinate set. Using BIM360 Coordinate it is possible to

see all clashes between models inside it.

) AUTODESK BIM 360 | undefined > GD-EUR-BIM360 TEST ~

it Model Coordination MODELS

& N @

Project Home Insight Document
Management
- ©
o \e} @
Co>- ®
Project Model Field
Management Coordination Management
Assets Project Admin Account Admin

BIM 360 Glue [

Privacy | Terms and Conditions

Figure 51: Model coordination set within BIM 360.
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Once entered into the Model Coordination there are three different sections:
Models, in which it is possible to see all models uploaded in BIM360, Clashes, in
which it is present a table that shows the number of clashes present between
different models, and Views, where are saved the screens done through the

models.

) AUTODESK BIM 360 | undafined ; GD-EUR-BIM360 TEST =

i Model Coordination MODELS  CLASHES  VIEWS

MTLIT3_A1_E_FUN_SCC_V_00Lrvt - {30}
266 clash groups

MTLIT3_A1_E_IIA_SCC_V_00Lrvt - {3D}
55 clash groups

MTLIT:
260 cf

_E_IVC_SCC_V_001_02.rvt - {30}
roups

MTLIT3_A1_E_STR_SCC_V_0O0Lrvt - {30}
115 clash groups

Figure 52: Table present into the clashes section.

Clicking on a specific combination of models present into the table it is visualized
the 3D view of the models and the present clashes are highlighted.
A very useful aspect of the Model Coordination tool is that it is possible to assign
the solution of a specific clash to a person inside the project and it is done
selecting the clash and then clicking on the “Issue” tab that is present at the

bottom of the clashes window as it is possible to see into the following figure.
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Viewing 2 models (Unsaved View) ~

D Clashes

w Filter and group =

A Primary model

MTLIT3_A1_E_FUN_SCC_V_00Lrvt-{3D} =

Clash with

MTLIT3_AL_E_LIA_SCC_V_00Lrvt - (30} =
Group by

Object -

[ 54 CLASHES (5 Selected)

— Basic Wall [649377]
= 1clash with 1 ather madel

Basic Wall [649583]
1 clash with 1 other model

Basic Wall [653390]

¥ 4 clashes with 1 other model "_‘A 7“':1
0 . i
R A I L R o
—— w ~ i

Figure 54: 3D view of a clash between ITA and FUN models.

In this section you can also define other characteristics of the clash as: type,
status, title, due date and location. The responsible of the clash receive a mail with

the issue notification.

Viewing 2 models (Unsaved View) -
O Issues X
) New Issue I
A

Type =

Coordination -

Status *

§ Open

Title *

Pipes/Wall§
Assign To
Greta Lucibello

Due Date

Location

Enter Location -

Locatien Details

Enter Location Details -

Figure 53: Characteristics that is possible to set into a clash.

At this point it is the assigned clash is visible into the Attachment set of the Issue
section and it is represented by a yellow point into the 3D view.
If the person responsible of the issue answer to it, the status of the clash change

and it appear with a blue point into the 3D view instead of yellow.
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Viewing 2 models (Unsaved View) ~

Drag and drop files here or browse

i screenshot_2020-11-1..

Viewing 2 models (Unsaved View) -

Filter » Sort =

\Y Nov 10, 202
#3 - Test from Navis ta BIM360

#2 - Basic Wall [646377] and Rectangular Duc..

#1 - Test

FeunEt|seecelraos )
Figure 56: Different kind of issues.

Those assigned issue appear listed into the Assigned set under the Clashes section
of the Model Coordination. [12]

AUTODESK BIM 360° | undefined ; GD-EUR-BIM360 TEST =

# Model Coordination

Clas Detection - SCC¥

Assigned Closed Last clash check 6 Nov 2020 10:09
0] v Title Assigned to Company Due date Linked document (V] 8
Pipe VS Wall Gabriella Monticelli  Politecnico di Torino - MTLIT3_A1_E_FUN_SCC_V_001.rvt - {30}
I 2 Basic Wall [646377] and Rectangular Duct [627614] Gabriella Monticelli  PolitecnicodiTorino 10 Nov 2020 MTLIT3_A1_E_FUN_SCC_V_00Lrvt - {30}

Figure 55: List of assigned issues.
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Some useful outputs of BIM 360 are represented by the Insight section.
To have them go to the BIM 360 Module Picker and select Insight (1). Along the
top, to the far right of the tab options select Reports (2). Below that, switch from
Recent to Saved (3). Finally, select the blue button on the right “Create

Report”(4).

Figure 58: Insight section of BIM360. [https://knowledge.autodesk.com/support/bim-360/learn-
explore/caas/simplecontent/content/automating-bim-360-model-coordination-clash-reports.html]

With “Data” selected on the left side of the screen, configure the sorting and
filtering options to make your report specific to a company, and the coordination

issues assigned to them.

Sort first by ID, then set the secondary sort option based on your needs (1). In the

Type filter option, select “Coordination” (2).

Status can be left blank to report all options, or you can select all status’ that are

not Closed if you want to exclude Closed issues from your report.

In the ‘Assigned To’ field select the Member, Role or Company that you want to
filter on. This needs to coincide with the format you are assigning issues in Model
Coordination. If you are assigning by company name, select the company name
in the drop down associated with this report. If issues are assigned to individual

members within a company, select that member in this field (3).
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T ——r—

i Insight " :

ot RS [ -]
Tvpe o
fu— 5 I8

Figure 59: Setting options within Report. [https://knowledge.autodesk.com/support/bim-360/learn-
explore/caas/simplecontent/content/automating-bim-360-model-coordination-clash-reports.html]

Working on a construction project can involve hundreds of subcontractors,
thousands of issues, and a daily changing environment. Insight is an ecosystem
that delivers unified project-level data, analytics, and predictive insights. It can
help get you up to speed with what's going on in a project, assess trends and
patterns in project data, identify any gaps and problems, and use predictive risk

data to improve project efficiency.

Navigate between the tabs to view different areas of Insight and then use the cards

on each tab to review project data. [22]

AUTODESK BIM 3607 | F

i Insight

College

Project Design Coordinatien lssues by Company

Q

B

©® 0B B

Coordination Issues: Active s Closec

Coordination [ssues Status

Figure 60: Insight output of BIM360. [https://get.construction.autodesk.com/bim36omc-navisworks-
integration-webinar-ungated/? _ga=2.159291325.647887994.1606296178-362227237.1569592853]
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Insight aggregates all data across the different areas of the project, especially
Issues. It is possible to create a dashboard like in the previous figure in which it

is possible to manage the view. [18]

7.4 BIM 360 Coordinate and Navisworks interoperability

One of the most interesting aspects is that it is possible to make in communication
BIM 360 and Navisworks. In order to do that it is important to upload a
Navisworks file with .nwd extension on BIM 360 Coordinate and also it is
fundamental to install on the computer a Desktop Connector for BIM 360 that

will appear within the explorer folder.

Once models are uploaded on BIM 360, they can be opened from Navisworks
following this procedure: Click on the Coordination tab > Coordination panel >
Open Models > Select BIM 360 account from the drop-down list > Click on the
project > Click Open.

Consequently, to see the issues added on BIM 360 it is necessary to: Click the
Coordination tab > Issues panel > Manage issues to open the BIM 360 Issues
panel. In this way Issues are displayed on the model as push pins and listed in the
panel. Clicking Refresh in the panel changes are loaded to issue data and

synchronized between BIM 360 and Navisworks. [17],[18],[19],[23]

COMPLEMENTARY TOOLS FOR BETTER
COORDINATION

g] __ BETTER

COORDINATION
FOR

e

¢

Figure 61: Interoperability between BIM 360 and Navisworks.
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Autodesk Navisworks Manage 2021 Untitled Type R0
Home  Viewpoint Review Animation View Output BIM 360 Glue Render [eGIGIRENII] o~
BIM 360 Coordination x
Open
Coordination | Issues | About
Select account and project Select coordination space Filter models or view
undefined v Clas Detection - SCC v )
Models View 4 models

MTLIT3_AL_E_FUN_SCC_V_00Lrvt - {30}

MTLIT3_AL_E_ITA_SCC_V_00Lrvt - {30}

MTLIT3_AL_E_IVC_SCC_V_001_02.rvt - {30}

MTLIT3_AL_E_STR_SCC_V_0OLrvt - {30}

e Open All

Figure 62: Model opening in Navisworks.

Autodesk Mavisworks Manage 2021

Home  Viewpoint Review Animation View Output BIM 360 Glue Render [ReGLIGIEfeh]

Q R:_
OO /'_'lJ

Open Manage| About
Models Issues

Coordination | Issues | About

Figure 63: Manage issue tab.
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Home  Viewpoint Review  Animation

o8 & @

Open Manage|| About
Models Issues

Coordination | Issues | About

BIM 360 Issues

Viy

&, Refresh (?) Help

Filter = Sort = ﬂ]

[ OPEN ] Unspecified

#4 - Pipe VS Wall

Assigned to: Gabriella Monticelli
Location: Unspecified

[ OPEN ] Nov 10, 2020

#3 - Test from Navis to BIM360

Assigned to: Gabriella Monticelli
Location: Unspecified

[ ANSWERED ] Nov 10, 2020

#2 - Basic Wall [646377] and Rectangul...

Assigned to: Gabriella Monticelli
Location: Unspecified

[ OPEN ] Nov 10, 2020

#1 - Test

Assigned to: Gabriella Monticelli
Location: Unspecified

Figure 64: List of issues displayed.
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The integration between BIM 360 and Navisworks allows project teams to save
time with automated clash detection, increase the quality of the models, and
create a single source of truth for issue management across the entire project

team.

This approach ultimately enables the issue to be tracked by the VDC manager
through to resolution all from within Navisworks and in empowering anyone to
be involved in the coordination process, represents an entirely new way to

manage the model coordination workflow.
With this tool project teams can:

e Create and assign issues directly from Navisworks
e Save hours with automated clash detection in BIM 360 Model
Coordination

e Maintain a common data environment for the entire coordination process

With the integration, users can create and view issues in either Navisworks or
BIM 360 Model Coordination. This allows for a complementary workflow that
enhances existing Navisworks-based processes and empowers Model
Coordination users to do more specific clash detection and analysis in
Navisworks. And, with the Revit Issues Add-in (currently in open beta), users can
open Revit and view BIM 360 issues, fully closing the workflow between design

and construction teams. [31]
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8 Conclusions

To conclude with this thesis, the author would like to sum up what he has learned

during her experience with BIM methodology.

The modelling process is very tedious at first, for unexperienced users. Plenty of
mistakes are made due to the lack of knowledge about the software and their
tools. However, it is important to be alert to these mistakes in order not to repeat
them, since working in a wrong way leads to inconsistency problems that make

the model useless for being used for other scopes.

The creation of a BIM guide with specification on standards is strongly useful for
the modeller to have an idea which are the limits of the model. Specifying the
parameters that will be used help the designers to avoid information
inconsistencies and consequently hard work changing parameter values.
LOD specification not only improve communication between contractors but also
helps the designer identify when something is worth to be modelled and when

becomes a time waste.

In conclusion, the elaboration of thesis has faced several topics whose thread is
the BIM methodology. The aim was to demonstrate how the use of these

technologies can bring many benefits.

It must be remarked that working with BIM based software usually requires a
high computational potential, so, companies that would want to introduce BIM
methodology must think in making an investment not only in training personal

but also in technology.

The final phase of this thesis focuses on the clash detection verifications and in
particular to the comparison between the use of different software. To make those
comparisons it has been necessary to download different external tool and plug-
in and try different work paths to make the process work well. This phase is been
particularly hard and takes a lot of time because of the use of different software

that were unknown to the author.
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Conclusions

It can be said that the work carried out represents a practical application, aimed

at highlighting the benefits and some criticalities of BIM processes and tools.

8.1 Future development

Future developments certainly include the resolution of interferences between

MEP models and structural and architectural models.

Other analyses that can be carried out for completeness concern the other
dimensions of the BIM: a 4D analysis to perform a simulation of the expected
times for the construction phase, a 5D analysis to have an estimation of the costs
for construction and maintenance of the structure, a 6D analysis for the
management of the same and finally a 7D analysis for the maintenance of the

station.

In addition, a possible development could be represented by the navigability of

the model by means of virtual reality.

Obviously, this would make more sense if developed for the entire metro line of

the city of Turin.
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